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Patents

Return Goods Policy
Return goods cannot be accepted without prior authorization and are subject to a 
restocking charge. The Seller certifies the articles specified herein were produced in 
compliance with all provisions of the Fair Labor Standards Act of 1938, as amended, 
including Section 12.—Rev. 6/98

Reporting Errors and Recommending 
Improvements
To report errors or recommend improvements to this manual, please complete the 
Document Evaluation Form in the appendices. Mail or fax the form to:

MiTek, Machinery Division
301 Fountain Lakes Industrial Drive
St. Charles, MO 63301
Attn: Engineering Manager
Fax: 636-328-9218

Your support in helping MiTek provide unsurpassed machinery and support is appreciated.

Made and sold under one or more of the following patents:
U.S. 37,797 U.S. 5,468,118
U.S. 5,553,375 U.S. 6,079,325
U.S. 6,145,684 U.S. 6,330,963
U.S. 6,405,916 U.S. 6,651,306
U.S. 6,807,903 Other Patents Pending

Legal Notice
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MatchPoint PLANX™
Servo-Driven Jigging System
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or Notice # Dated Title

Notice of Change



001098 Rev. B Safety (English)
IN-1

Safety Indicators: Signal Words
The following signal words and colors are used throughout this document to indicate 
safety hazards. Pay careful attention when you see them. The level of severity differs for 
each signal word and color.

Signal words are accompanied by graphics showing what personnel should or should not 
do. The graphics are called safety symbols and are defined on page 13, but more specific 
text is provided every time a graphic is used throughout the manual. Everyone near the 
machine must be trained on how to read these safety indicators.

Failure to comply with the instructions accompanying each signal word may result in 
property damage, personal injury, or even death. Personnel must follow all safety 
procedures and practices to ensure the safest possible operation of this equipment. 
However, at no time is this document a substitute for common sense. Personnel must 
ensure that the work environment is safe and free of distractions.

DANGER
Indicates an imminently hazardous situation which, if not avoided, is 
likely to result in death or serious injury.

WARNING
Indicates a potentially hazardous situation which, if not avoided, may 
result in death or serious injury.

CAUTION
When CAUTION is used with the safety alert symbol (yellow triangle), 
it indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury.

When CAUTION is used without the safety alert symbol, it indicates a 
potentially hazardous situation which may result in equipment damage.

NOTICE
Calls attention to information that is significant to understanding the 
operation at hand.

ENVIRONMENTAL
Applies to conditions that may affect the environment but do not have 
an immediate, direct effect on personnel or equipment.

Refiérase a la 
página 22 para 
español.

For safety 
information in 
Spanish, refer to 
page 22.

Safety (English)
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General Equipment Safety Rules
Because it is impossible to anticipate every circumstance that might involve a hazard, the 
safety information provided in this equipment manual and on the machine is not all-
inclusive. If this machine is operated or serviced using a procedure not specifically 
recommended by the manufacturer, the procedure shall be approved by a professional 
engineer to ensure it will not render the equipment unsafe. Use extreme caution and 
common sense at all times!

Know Your Equipment
• Read this manual completely before using or maintaining the equipment. Do not 

operate this machine unless you have a thorough knowledge of the controls, safety 
devices, emergency stops, and operating procedures outlined in this manual.

• Read and follow all safety notes. Failure to comply with these instructions may 
result in economic loss, property damage, and/or personal injury including death.

• Refer to the lockout/tagout guidelines on the following pages to safely perform 
maintenance and troubleshooting of this equipment.

• Observe and obey all safety labels. Replace worn labels immediately.
• Use this equipment solely for the purpose described in this manual.
• Only qualified personnel should attempt to operate or perform maintenance on this 

equipment. “Qualified personnel” is defined as:

 ...a person or persons who, by possession of a recognized degree or 
certificate of professional training, or who, by extensive knowledge, 
training, or experience, has successfully demonstrated the ability to solve 
problems relating to the subject matter and work—ANSI B30.2-1983

...one who has skills and knowledge related to the construction and 
operation of the electrical equipment and installations and has received 
safety training on the hazards involved—NEC 2002 Handbook

Personal Safety
• Always wear safety glasses and hearing protection in an industrial environment.
• Utilize a filtering face piece (dust mask) when working near sawdust.
• Wear proper clothing and appropriate personal protective equipment (e.g., safety 

glasses and hearing protection.) Do not wear loose clothing or jewelry. Confine 
long hair by tying it back.

• Use caution when lifting heavy parts or material.
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Installing the Equipment
• Follow installation instructions completely.
• This equipment is not for use in a residential area.

Lockout/Tagout
• Before performing maintenance on the pneumatic or hydraulic systems, bleed the 

lines to eliminate pressure.
• Lockout/tagout all energized systems before performing maintenance on them. 

Refer to the Lockout/Tagout Guidelines section on page 5.

Keeping a Safe Environment
• Keep children away. All visitors should be kept a safe distance from the work area. 

Hazards may not be apparent to individuals unfamiliar with the machine.
• Keep work areas well lit.
• Keep the work area clean and free of any trip or slip hazards.
• Do not use the equipment in damp or wet locations, or expose it to rain or snow. 
• Minimize dust clouds and protect your equipment by cleaning dust in this manner:

• Vacuum dust prior to blowing with air
• Shut down electrical power and sources of ignition
• If using compressed air, it should be a low compression (no more than 15 psi)
• Powered cleaning equipment such as vacuums must be consistent with local 

governmental codes for use in dusty conditions.

Operating and Maintaining the Equipment
• Ensure that all people, tools, and foreign objects are clear of the restricted zones 

before operating this equipment. The restricted zones are shown on page 11.
• Perform safety tests to ensure all E-stops are working properly before operating the 

equipment at the initial startup, after performing any maintenance, and in 
accordance with the maintenance schedule.

• In case of machine malfunction, stop the machine immediately using an E-stop and 
report the malfunction to a supervisor.

• Never leave the machine running unattended. Turn the power off! Do not leave the 
machine until all parts have come to a complete stop and all electrical power has 
been shut off.

• Check for worn or damaged parts regularly. Repair or replace them immediately.
• Keep the hydraulic, pneumatic, and electrical systems in good working order at all 

times. Repair leaks and loose connections immediately. Never exceed the 
recommended pressure or electrical power.



MatchPoint PLANX™ Jigging System

001098 Rev. B Safety (English)
IN-4

• Check that all safety devices are in working order before each shift starts. All 
protective guards and safety devices must be in place before and during use of the 
machine. Never disconnect or bypass any safety device or electrical interlock.

• Only qualified maintenance personnel shall remove or install safety devices.
• Periodically inspect the quality of the finished product.

Electrical Safety
• Do not use any liquids in the interior of electrical cabinets.
• When using solvents on and around the machine, remove power to the machine to 

eliminate the chance of sparking, resulting in explosion or fire. Wear a respirator 
approved for use with solvents. Wear protective clothing, gloves, and safety glasses.



MatchPoint PLANX™ Jigging System

001098 Rev. B Safety (English)
IN-5

Lockout/Tagout 

Lockout/Tagout Guidelines

All lockout/tagout guidelines must be met according to 
OSHA 29 CFR 1910.147. A specific procedure should be 
included in your company’s energy control program. This 
manual is not intended to replace your company’s de-
energizing or lockout/tagout procedure required by OSHA, 
but merely to provide general guidance.

The term “lockout,” as used in this manual, means placing a 
lockout device on any and all energy sources to ensure that the 
energy isolating device and the equipment being controlled 
cannot be re-energized or operated until the lockout device is 
removed. The photos on the next page show where the 
electrical disconnects are located for this machine.

• Energy sources include electrical, mechanical, hydraulic, pneumatic, chemical, 
thermal, or other energy.

• In the case of electrical energy sources, the main power and control power to the 
machinery must be turned off and physically locked in the “off” position.

• A lockout device is usually a keyed padlock.
• If more than one person is working in a restricted zone, use a group lockout device 

that will allow each person to use a lock that can be removed only by the person 
performing the maintenance.

“Tagout” means that a prominent warning is securely fastened to an energy-isolating 
device to indicate that the equipment shall not be operated.

Whenever you see this symbol, lockout/tagout!

Your Name Today’s Date
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Electrical Lockout/Tagout Procedures

When Working on a Machine Outside the Machine’s Main Electrical 
Enclosure

Before performing maintenance on any machine with electrical power, lockout/tagout the 
machine properly. When working on a machine outside of the machine’s main electrical 
enclosure, not including work on the electrical transmission line to the machine, follow 
your company’s approved lockout/tagout procedures which should include, but are not 
limited to the steps here.

1. Engage an E-stop on the machine.

2. Turn the disconnect switch handle to the “off” position. See Figure SAFETY-1.

3. Attach a lock and tag that meet OSHA requirements for lockout/tagout.

4. Restrain or de-energize all pneumatic components, hydraulic components, and 
other parts that could have live or stored power.

If working on the electrical transmission line to the machine, 
follow the procedure on page 8.

! WARNING
ELECTROCUTION HAZARD.

When the disconnect switch is off, there is still live 
power within the disconnect switch’s enclosure. 
Always turn off power at the building’s power source 
to the equipment before opening this electrical 
enclosure!
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Figure SAFETY-1: Sample of a Lockout/Tagout Mechanism on an Electrical 
Enclosure

Sample of a 
Lock and Tag 
Attached to a 

Machine’s 
Electrical Enclosure
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When Working on a Machine Inside the Machine’s Main Electrical Enclosure 
or in the Electrical Transmission Line to the Machine

Before opening the main electrical enclosure, or attempting to repair or replace an 
electrical transmission line to the machine, lockout/tagout the machine properly. Follow 
your company’s approved lockout/tagout procedures which should include, but are not 
limited to the steps here.

1. Engage an E-stop on the machine.

2. Shut the power to the machine off at the machine’s power source which is usually 
an electrical service entry panel on the facility wall. One example of a locked-out 
power source panel is shown in Figure SAFETY-2.

3. Attach a lock and tag that meets OSHA requirements for lockout/tagout.

4. Open the door to the enclosure in which you need access, and using a multimeter, 
verify that the power is off.

Figure SAFETY-2: Sample of a Lockout/Tagout 
Mechanism on a Power Source Panel
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Pneumatic System Lockout/Tagout Procedure

When Lockout/Tagout is Not Required

If working on components other than the pneumatic system, but that requires you to be 
near the vicinity of movable pneumatic components, you must, at a minimum, physically 
restrain the pneumatic components from moving. If this is not possible, lockout/tagout the 
entire pneumatic system.

When Lockout/Tagout is Required

Before attempting repair or maintenance on a pneumatic line or component, lockout/ 
tagout the machine properly. Follow your company’s approved lockout/tagout procedures.

Troubleshooting With an Energized Machine
Only a qualified electrician, using the personal protective equipment and following the 
procedures recommended in NFPA 70E should ever attempt service or repair of or near an 
energized area or component of the machine.

Whenever maintenance is performed while the equipment is electrically energized, there is 
a potential electric arc flash hazard. Refer to NFPA 70E for the personal protective 
equipment required when working with electrically energized components. Pneumatic and 
hydraulic components may move unexpectedly if not de-energized. Physically restrain any 
components capable of movement when working on or near those components.
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Safety Test
This test procedure MUST be performed by qualified personnel at startup and after ANY 
maintenance, adjustment, or modification. Testing ensures that the safety system and 
machine control system work together to properly stop the machine.

1. Start the system.

2. Test that the E-stop circuit prevents movement:

a) While jigging a truss automatically, push the red E-stop button on the 
operator control station. All PLANX should stop immediately.

b) Attempt to manually run the pucks on the first PLANX assembly by 
pressing the FWD/REV button located on the control box for that 
PLANX assembly.

c) The pucks should not move! Repair the electrical system if the puck 
moves while the E-stop is actuated.

d) Repeat for all other PLANX assemblies.

e) Reset the E-stop circuit after testing by pulling straight out on the red 
Estop button, then pressing the RESET button.

3. Lockout/tagout.

4. Check that all guards and safety devices are in place and secure.

5. Inspect the timing belts (2 per PLANX) for excessive wear.

6. Inspect the Acme screws and nuts for excessive wear. Rotate the Acme screw to 
check the back side of crew.

7. Remove any foreign objects that may have fallen into the PLANX slot.

8. Ensure that the Acme screws are lubricated. See the Maintenance Checklist.

9. Remove the lockout/tagout devices.
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Restricted Zone

Know the Restricted Zone

! DANGER
Stay out of the restricted zone when equipment is in 
use. Serious injury or death may result if personnel 
are in the restricted zone.

Always look for personnel in the restricted zone 
before operating equipment.

Gantry Head

Tables

Parking Stand

Conveyors

Finish Roller

Conveyors
Stackers 
(Not Shown)
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Marking the Restricted Zone

The restricted zone must be marked so everyone near the equipment can clearly see the 
area where danger may exist. 

MiTek offers Restricted Zone Tape that is easy to apply and has text in English and 
Spanish. Some equipment comes with restricted zone tape. If your machine did not come 
with restricted zone tape, you may order it from MiTek Machinery Division Customer 
Service.

Instructions for where and how to apply restricted zone tape can be found in the gantry 
manual that came with your system or by obtaining Service Bulletin 181 from the MiTek 
Machinery Web site.
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Safety Symbol Definitions
The safety symbols shown in this section can be found throughout the manual to indicate 
hazards that are related to this equipment. All personnel expected to operate or maintain 
this equipment should become familiar with these safety symbols and what they mean.

This is the Electrical Hazard Symbol. It indicates that there are 
dangerous high voltages present inside the enclosure of this 
product and/or that a power source is present. To reduce the risk 
of fire or electric shock, do not attempt to open the enclosure or 
gain access to areas where you are not instructed to do so. Refer 
servicing to qualified service personnel only.

This product should be operated only from the type of source 
indicated on the manufacturer's identification label. Installation 
should be in compliance with applicable sections of the national 
electric code. Consult your local building code before installing.

This is the user caution symbol. It indicates a condition where 
damage to the equipment resulting in injury to the operator could 
occur if operational procedures are not followed. To reduce the 
risk of damage or injury, refer to accompanying documents, follow 
all steps or procedures as instructed.

Operation of this equipment may result in flying debris and 
excessive noise. To reduce the risk of injury, wear only approved 
PPE.

Crush hazard! Keep hands clear.

Keep hands away from moving parts.
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Do not use sling equipment rated for less than ____ lbs/___kgs 
when lifting this equipment.

Crush hazard from above

Trip hazard! Pay attention when walking in this area.

Keep hands and body clear.

WARNING! ___ MAN LIFT REQUIRED TO SAFELY MOVE THIS 
EQUIPMENT. REFER TO INSTALLATION MANUAL.
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The operation of this equipment requires the use of PPE.

Do not operate without wearing required protective clothing.
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Refer to manual- After installation, read the user's guide carefully 
before operating. Follow all operating and other instructions 
carefully.

Circuits are live -lockout/tagout the upstream disconnecting 
means prior to opening for service.

Lockout in a de-energized state

Lift Point - In order to reduce the likelihood of damage to the 
equipment, use only the lift points indicated in the manual.

Use of lift equipment is mandatory.
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Consult material safety data sheet.

Read all safety warnings and instructions before proceeding.

Unplug equipment before servicing.

Hazardous moving parts are located behind this access panel. Do 
not operate this equipment without all guards and covers in place.

Do not place containers with liquids such as coffee, water, sodas, 
etc. on this unit.

Do not operate this equipment in a wet environment.

Do not expose to water

Use of fork lift equipment when moving this equipment will result 
in serious equipment damage. Refer to installation procedures.
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Do not use non-approved lubricants in this machine.

Do not operate without guards and covers in place

Do not weld

Do not discard into municipal waste stream

oil drop
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Declarations of Conformity for CE Compliance

EU DECLARATION OF CONFORMITY 
WITH

COUNCIL DIRECTIVE 2006/42/EC 
CE DECLARATION DE CONFORMITE 

AVEC DIRECTIVE 2006/42/EC 

Date of Issue: 30 OCT 2009 

Directive: Machinery Safety Directive, 2006/42/EC 
Conforming Machinery: Servo PlanxTM

S/N: As Stamped on Nameplate 

Manufacturer: MiTek Industries, Inc. 
301 Fountain Lakes Industrial Drive 
St. Charles, MO 63301 
USA

Authorized Representative Syd Griffiths 
Managing Director Europe 
MiTek Industries Limited 
MiTek House 
Grazebrook Industrial Park 
Peartree Lane 
Dudley, West Midlands DY2 0XW 
England 
Ph: (44) 1384 451400 

Harmonised Standards 
Referenced or Applied: 

BS EN 12100-1:2003, BS EN 12100-2:2003, BS EN 13857:2008, BS 
EN ISO 13850:2008, BS EN 60204-1:2006, BS EN ISO 14121-1:2007, 
BS EN 349:1993+A1:2008, BS EN 953:1997 +A1:2009, BS EN 
1037:1995+A1:2008, BS EN 60529:1992.  BS EN 614-
1:2006+A1:2009 

Specifications with which Conformity is 
Declared: 

Essential Health and Safety Requirements of Annex 1 of the Machinery 
Directive 

We hereby certify that the machinery described above conforms with the essential health and safety 
requirements of Council Directive 2006/42/EC on the approximation of the laws of the Member States relating to 
the safety of machinery. 
Signed: 

Signatory:  Printed Name         Manish Kanjee 

Title                       Engineering Manager 

Company Name     MiTek Industries, Inc. 

Technical File Reference Number 
SF10753A1.MII
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Notes Concerning Harmonized Standards Referenced or applied: 
 

BS EN ISO 12100-1:2003 Safety of machinery. Basic concepts, general 
principles for design. 

BS EN ISO 12100-2:2003 Safety of machinery - Basic concepts, general 
principles for design - Part 2: Technical 
principles - /A1 

BS EN 60204-1:2006 Safety of machinery. Electrical equipment of 
machines. General requirements. 

BS EN ISO 13857:2008 Safety of machinery. Safety distances to 
prevent hazard zones being reached by upper 
and lower limbs. 

BS EN 349:1993+A1:2008 Safety of machinery. Minimum gaps to avoid 
crushing of parts of the human body. 

BS EN 953:1997 +A1:2009 Safety of machinery. Guards. General 
requirements for the design and construction of 
fixed and movable guards. 

BS EN 1037:1995+A1:2008 Safety of machinery. Prevention of unexpected 
start-up 

EN ISO 13850:2007 Safety of machinery — Emergency stop — 
Principles for design. 

BS EN 60529:1992 Specification for degrees of protection provided 
by Enclosures (IP Code). 

BS EN ISO 14121-1:2007  Safety of Machinery – Risk Assessment – Part 
1: Principles 

BS EN 614-1:2006+A1:2009 Safety of machinery — Ergonomic design 
principles —. Part 1: Terminology and general 
principles 
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Declaration of Noise Emissions

Declaration of Noise Emission 

The MiTek® Industries, Inc. Model Servo PlanxTM noise emission 
levels per ISO EN 11202 are as follows: 

Electronics Console Work place noise level (Work 
Cycle)

79.0 dB (A)

Servo PlanxTM  Work place noise level (Work Cycle) 82.6 dB (A)

Ambient Correction Factor K3A calculated 
according to ISO EN 11204 Appendix A. 

4 dB (A)

Measurements were made at a height of 1.5 m and 1 m from the machine. 

The difference between the extraneous noise level and the sound intensity 
level at each measuring point is > 6 dB (A) 

The figures quoted are emission levels and are not necessarily safe working 
levels. While there is a correlation between the emission and exposure 
levels this cannot be used reliably to determine whether or not further 
precautions are required.

Factors that influence the actual level of exposure of the workforce include 
characteristics of the work room, the other sources of noise, etc. such as the 
number of machines and other adjacent processes. Also, the permissible 
level of exposure can vary from country to country.

This information, however, will enable the user of the machine to make a 
better evaluation of the hazard and risk. 

MiTek® Industries, Inc. 
301 Fountain Lakes 

Industrial Drive 
St. Charles, MO 63301 

USA
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Sea cuidadoso.
Protéjase.

Seguridad (Español)
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Indicadores de seguridad: Palabras de aviso
Las siguientes palabras y colores de aviso se utilizan a lo largo de este documento para 
indicar riesgos de seguridad. Preste suma atención cuando los vea. El nivel de gravedad es 
diferente por cada palabra o color de aviso.

Las palabras de aviso van acompañadas por gráficos que muestran al personal lo que 
deben y no deben hacer. Los gráficos se llaman símbolos de seguridad y se definen en la 
página 13, pero se proporciona un texto más específico cada vez que se utiliza un gráfico 
por todo el manual. Todas las personas que estén cerca de una máquina tienen que ser 
capacitadas en cómo leer estos indicadores de seguridad.

No cumplir las instrucciones que acompañan cada palabra de aviso puede producir daños a 
la propiedad, lesiones personales e incluso la muerte. El personal debe seguir todos los 
procedimientos y prácticas de seguridad establecidos para asegurar el uso más seguro 
posible de este equipo. No obstante, en ningún caso este documento reemplaza el sentido 
común. El personal debe asegurarse de que el entorno de trabajo sea seguro y esté libre de 
distracciones. 

PELIGRO
Indica una situación potencialmente peligrosa que, si no se evita, 
podría producir la muerte o lesiones graves.

ADVERTENCIA
Indica una situación potencialmente peligrosa que, si no se evita, 
podría producir la muerte o lesiones graves.

PRECAUCIÓN
Indica una situación potencialmente peligrosa que, si no se evita, 
puede producir lesiones menores o moderadas.

AVISO
Llama la atención a información importante para entender la operación 
que se desea realizar.

AMBIENTAL
Se aplica a condiciones que pueden afectar el entorno pero que no 
tienen un efecto inmediato o directo sobre el personal o el equipo.
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Reglas de seguridad para el equipo de general
Debido a la imposibilidad de anticipar todas las circunstancias que podrían constituir un 
riesgo, la información de seguridad suministrada en este manual del equipo y sobre la 
máquina no es exhaustiva. Si se utiliza o realiza el mantenimiento de esta máquina 
utilizando un procedimiento no recomendado específicamente por el fabricante, el 
procedimiento deberá ser aprobado por un ingeniero profesional para asegurarse de que no 
afecte la seguridad del equipo. ¡Manéjese siempre con suma precaución y sentido común!

Conozca su equipo
• Lea este manual en su totalidad antes de utilizar o mantener el equipo. No utilice 

esta máquina a menos que esté perfectamente familiarizado con los controles, los 
dispositivos de seguridad, los frenos de emergencia y los procedimientos operativos 
que se describen en este manual.

• Lea y siga todas las notas de seguridad. El no cumplimiento de estas instrucciones 
podría producir pérdidas económicas, daños a la propiedad y lesiones personales, 
incluida la muerte.

• Refiérase a las pautas de bloqueo/etiquetado proporcionadas en las siguientes 
páginas para realizar el mantenimiento y solucionar problemas de este equipo en 
forma segura.

• Observe y cumpla con todas las etiquetas de seguridad. Cambie las etiquetas 
gastadas inmediatamente.

• Utilice este equipo únicamente para el propósito que se describe en este manual.
• Sólo personal calificado debe intentar utilizar o realizar el mantenimiento de este 

equipo. Por "personal calificado" se entiende:

 ...una persona o personas que, por el hecho de poseer un título o certificado 
de capacitación profesional reconocido o que, por sus amplios 
conocimientos o experiencia, han demostrado con éxito estar capacitados 
para resolver problemas relacionados con el tema y el trabajo en cuestión
—ANSI B30.2-1983

...una persona que posee habilidades y conocimientos relacionados con la 
construcción y uso de equipos e instalaciones eléctricas y que ha recibido 
capacitación en seguridad sobre los riesgos posibles—NEC 2002 Handbook

Seguridad personal
• Use siempre lentes de seguridad y protección auditiva en un entorno industrial.
• Utilice una máscara protectora cuando trabaje cerca de aserrín.
• Utilice ropa adecuada y equipo de protección personal apropiado (por ejemplo, 

lentes de seguridad y protección auditiva.) No use ropa suelta ni joyas. Si tiene el 
cabello largo, áteselo para atrás.

• Proceda con precaución cuando levante piezas o materiales pesados.
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Instalación del equipo
• Siga las instrucciones de instalación al pie de la letra.
• No utilizar este equipo en zonas residenciales.

Procedimientos de Bloqueo/Etiquetado
• Antes de realizar el mantenimiento de los sistemas neumáticos o hidráulicos, 

purgue las líneas para eliminar la presión.
• Bloquee y etiquete todos los sistemas energizados antes de realizar tareas de 

mantenimiento en ellos. Refiérase a la sección Pautas de bloqueo/etiquetado en la 
página 27.

Cómo mantener un entorno seguro
• Mantenga alejados a los niños. Todos los visitantes deben mantenerse a una 

distancia segura del área de trabajo. Los riesgos pueden no ser evidentes a las 
personas no familiarizadas con la máquina.

• Mantenga las áreas de trabajo bien iluminadas.
• Mantenga el área de trabajo limpia y libre de cualquier riesgo de tropiezo o 

resbalamiento.
• No utilice el equipo en lugares húmedos o mojados y no lo exponga a la lluvia o a la 

nieve.
• Minimice las nubes de polvo y proteja su equipo quitando el polvo de la siguiente 

manera:   
• Aspire el polvo antes de soplarlo con aire   
• Apague la alimentación eléctrica y todas las fuentes de ignición   
• Si usa aire comprimido, debe ser a compresión baja (no más de 15 psi)   
• El equipo eléctrico de limpieza como las aspiradoras debe cumplir con los 

códigos del gobierno local para uso en condiciones  polvorientas.  

Uso y mantenimiento del equipo
• Asegúrese de que no haya personas, herramientas y objetos extraños en las zonas 

restringidas antes de utilizar este equipo. Las zonas restringidas se indican en la 
página 33.

• Realice pruebas de seguridad para verificar que todos los frenos de emergencia 
funcionen adecuadamente antes de utilizar el equipo por primera vez, después de 
realizar cualquier tarea de mantenimiento y según la frecuencia de mantenimiento 
establecida.

• En caso de que la máquina no funcione correctamente, deténgala inmediatamente 
utilizando un freno de emergencia e informe el problema a un supervisor.
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• No deje nunca la máquina encendida si no está junto a ella. ¡Apáguela! No la 
abandone hasta que todas las piezas se detengan completamente y hasta que se haya 
apagado la alimentación eléctrica.

• Verifique periódicamente que no haya piezas gastadas o dañadas. Repárelas o 
cámbielas inmediatamente.

• Mantenga los sistemas hidráulicos, neumáticos y eléctricos en buen funcionamiento 
en todo momento. Repare las fugas y las conexiones sueltas inmediatamente. No 
exceda nunca la presión ni potencia eléctrica recomendadas.

• Verifique que todos los dispositivos de seguridad estén en buen funcionamiento 
antes de comenzar de cada turno. Todos los dispositivos protectores y de seguridad 
deben estar en su lugar antes y durante el uso de la máquina. No desconecte ni evite 
nunca ningún dispositivo de seguridad ni interbloqueo eléctrico.

• Solo el personal de mantenimiento calificado puede quitar o instalar los dispositivos 
de seguridad.

• Inspeccione periódicamente la calidad del producto terminado.

Seguridad eléctrica
• No utilice líquidos en el interior de los gabinetes eléctricos.
• Cuando utilice disolventes sobre o alrededor de la máquina, desconecte la 

alimentación para eliminar las probabilidades de chispas, que pueden producir una 
explosión o incendio. Use un respirador aprobado para el uso con disolventes. Use 
ropa protectora, guantes y lentes de seguridad.



MatchPoint PLANX™ Jigging System

001098 Rev. B Seguridad (Español)
Translation updated January 2012 IN-27

Bloqueo/Etiquetado

Pautas de bloqueo/etiquetado

Deben cumplir con todas las pautas de bloqueo/etiquetado 
conforme a la norma OSHA 29 CFR 1910.147. El programa 
de control de energía de la compañía debe incluir un 
procedimiento específico. El objetivo de este manual no es 
reemplazar el procedimiento de desenergización o bloqueo/
etiquetado requerido por la OSHA, sino proporcionar pautas 
orientativas generales.

El término "bloqueo", según se utiliza en este manual, se 
refiere a la colocación de un dispositivo de bloqueo en las 
fuentes de energía para asegurar que el dispositivo aislador de 
energía y el equipo controlado por éste no puedan 
reenergizarse o utilizarse hasta que se retire dicho dispositivo. 
Las fotos de la página siguiente muestran los lugares en los que se encuentran los 
interruptores de desconexión eléctrica de esta máquina.

• Las fuentes de energía incluyen energía eléctrica, mecánica, hidráulica, neumática, 
química, térmica y otras.

• En el caso de fuentes de energía eléctrica, la alimentación principal y la 
alimentación de control a la maquinaria deben apagarse y bloquearse físicamente en 
la posición "off" (apagado).

• Por lo general, como dispositivo de bloqueo se utiliza un candado con llave.
• Si hay más de una persona trabajando en una zona restringida, utilice un dispositivo 

de bloqueo grupal que permita a cada persona utilizar un candado que sólo pueda 
ser retirado por la persona que realiza el mantenimiento.

"Etiquetado" significa que debe colocarse una advertencia fácil de ver en un dispositivo 
aislador de energía que indique que el equipo no debe utilizarse.

Siempre que vea este símbolo, ¡Bloquee/Etiquete! 

Your Name Today’s Date

Su nombreLa fecha de hoy
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Procedimientos de bloqueo/etiquetado eléctricos

Cuando trabaja en una máquina fuera del gabinete eléctrico principal de la 
máquina

Antes de realizar el mantenimiento de cualquier máquina con alimentación eléctrica, 
bloquee y etiquete la máquina de forma adecuada. Cuando trabaje en una máquina fuera 
del gabinete eléctrico principal de la máquina, salvo en el caso de trabajos en la línea de 
transmisión eléctrica a la máquina, siga los procedimientos de bloqueo/etiquetado 
aprobados por la compañía, los cuales deberían incluir, entre otros, los pasos aquí 
indicados.

1. Coloque un freno de emergencia sobre la máquina.

2. Coloque el mango del interruptor con fusibles en la posición "apagado/apagada"..

3. Coloque un candado y una etiqueta que cumplan con los requisitos de bloqueo/
etiquetado de la OSHA.

4. Trabe o desenergice todos los componente neumáticos, componentes hidráulicos 
y otras piezas que tengan alimentación directa o almacenada.

Si trabaja en la línea de transmisión eléctrica a la máquina, 
siga el procedimiento de la página 30.

! ADVERTENCIA
RIESGO DE ELECTROCUCIÓN.

Cuando el interruptor con fusibles está apagado, 
sigue habiendo energía dentro del gabinete del 
interruptor. ¡Apague siempre la alimentación en la 
fuente de alimentación del edificio antes de abrir este 
gabinete eléctrico!
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Figura SEGURIDAD-1: Ejemplo de un mecanismo de Bloqueo/Etiquetado en un 
gabinete eléctrico

Ejemplo de un 
candado y etiqueta 
fijados al gabinete 
eléctrico de una 

máquina

NO 

UTILIZAR
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Cuando trabaje en una máquina dentro del gabinete eléctrico principal de la 
máquina o en la línea de transmisión eléctrica a la máquina

Antes de abrir el gabinete eléctrico principal o intentar reparar o reemplazar una línea de 
transmisión eléctrica a la máquina, bloquee y etiquete la máquina en forma adecuada. Siga 
los procedimientos de bloqueo/etiquetado aprobados por la compañía, los cuales deberían 
incluir, entre otros, los pasos aquí indicados.

1. Coloque un freno de emergencia sobre la máquina.

2. Apague la alimentación a la máquina en la fuente de alimentación, que, por lo 
general, es un panel de entrada de suministro eléctrico que se encuentra en una 
pared de las instalaciones. En la Figura SEGURIDAD 2 se muestra un ejemplo de 
panel de fuente de alimentación bloqueado.

3. Coloque un candado y una etiqueta que cumplan con los requisitos de bloqueo/
etiquetado de la OSHA.

4. Abra la puerta del gabinete al que necesita acceder y usando un multímetro 
verifique que la alimentación esté apagada.

Figura SEGURIDAD-2: Ejemplo de un 
mecanismo de Bloqueo/Etiquetado 
en un panel de fuente de alimentación
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Solución de problemas con una máquina 
energizada
Sólo un electricista calificado que utilice el equipo de protección personal y siga los 
procedimientos recomendados en la norma NFPA 70E debe intentar realizar tareas de 
reparación o mantenimiento en un área o componente energizados de la máquina o en su 
proximidad.

Cada vez que se realizan tareas de mantenimiento mientras el equipo está eléctricamente 
energizado, existe un riesgo potencial de formación de un arco eléctrico. Consulte en la 
norma NFPA 70E el equipo de protección personal requerido para trabajar con 
componentes eléctricamente energizados. Los componentes neumáticos e hidráulicos 
pueden moverse de manera imprevista si no se desenergizan. Trabe físicamente cualquier 
componente que pueda moverse cuando deba trabajar en ellos o en su proximidad. 
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Prueba de seguridad
Este procedimiento de prueba DEBE ser realizado por personal calificado durante la 
puesta en marcha y después de CUALQUIER tarea de mantenimiento, ajuste o 
modificación. La prueba permite comprobar si el sistema de seguridad y el sistema de 
control de la máquina funcionan juntos y detienen la máquina de manera adecuada. 

1. Ponga en marcha el sistema.

2. Pruebe que el circuito del freno de emergencia o E-stop evite el movimiento:

a) Al mover automáticamente un armazón, presione el botón rojo del freno 
de emergencia en la estación de control del operador. Todos los PLANX 
deberán detenerse de inmediato. 

b) Intente poner a funcionar manualmente los discos del primer montaje 
PLANX presionando el botón FWD/REV localizado en la caja de control 
del montaje PLANX.

c) ¡Los discos no deben moverse! Repare el sistema eléctrico si el disco se 
mueve estando activado el freno de emergencia.

d) Repita el procedimiento para todos los demás montajes PLANX. 

e) Restablezca el circuito del freno de emergencia después de la prueba 
jalando hacia afuera el botón rojo E-stop y luego presionando el botón de 
RESET. 

3. Procedimiento de bloqueo y etiquetado.

4. Compruebe que todos los protectores y dispositivos de seguridad estén en su lugar 
y asegurados. 

5. Inspeccione que las bandas de encendido (2 por PLANX) no estén desgastadas. 

6. Inspeccione los tornillos y las tuercas Acme para asegurarse de que no estén 
desgastados. Rote los tornillos Acme para revisar la parte posterior.

7. Elimine cualquier objeto extraño que haya podido caer en la ranura del PLANX.

8. Asegúrese de que los tornillos Acme estén lubricados. Consulte la Lista de 
comprobación de mantenimiento. 

9. Quite los dispositivos de bloqueo/etiquetado.



MatchPoint PLANX™ Jigging System

001098 Rev. B Seguridad (Español)
Translation updated January 2012 IN-33

Zona restringida

Conocer la zona restringida

! PELIGRO
Manténgase afuera de la zona restringida cuando el 
equipo esté en uso. Pueden producirse lesiones 
graves o incluso la muerte si el personal está en la 
zona restringida.

Asegúrese que no haya personal en la zona 
restringida antes de operar el equipo.

Cabeza de caballete

Tablas

Soporte de aparcamiento

Bandas transportadoras

Rodillo de acabado

Bandas transportadoras
Apiladores 
(no ilustrados)
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Marcar la zona restringida

Deberá marcarse la zona restringida de manera que todas las personas cerca del equipo 
puedan ver claramente el área donde pueda existir peligro.

MiTek ofrece la cinta de zona restringida o “Restricted Zone Tape”, fácil de aplicar y con 
texto en inglés y en español. Algunos equipos traen la cinta de zona restringida. Si su 
máquina no trajo la cinta de zona restringida, puede pedirla a MiTek Machinery Division 
Customer Service (Servicio al cliente de la división de maquinaria de MiTek).

Puede encontrar las instrucciones sobre dónde y cómo aplicar la cinta de zona restringida 
en el manual de su mesa o pórtico incluido con su sistema o pedir el Service Bulletin Kit 
181 en la página web de MiTek Machinery.

Información adicional

Definiciones de los símbolos de seguridad
(Safety Symbol Definitions) página 13

Declaraciones de Cumplimiento
(Declarations of Conformity for CE Compliance) página 19

Declaración de emisión de ruidos
(Declaration of Noise Emissions) página 21
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Introduction to the Manual

Purpose and Scope of This Manual

In order for this manual to be useful, it must be kept in a location where operators and 
maintenance personnel have easy access to it.

This manual addresses the most recent versions of the equipment as of the creation or 
revision date on the title page. For earlier revisions, contact MiTek Customer Service. The 
part number is listed on the title page, but the revision you require depends on the date 
your equipment was manufactured.

This manual can be a valuable training tool.

• The General Information chapter contains information on truss terminology and 
provides basic information about the equipment.

• The Operation chapter teaches operators how to efficiently operate the machine.
• The Maintenance chapter is written specifically for maintenance personnel.
• The appendices provide valuable technical information.

Purpose of 
Chapter

Purpose of 
Chapter

This chapter explains how to navigate through the equipment 
manual and how to contact MiTek.

! WARNING
Read this manual completely before using this 
equipment!

Do not operate this machine until you have a thorough 
understanding of all controls, safety devices, 
emergency stops, and operating procedures outlined 
in this manual.

All hazard instructions must be read and observed. 
Failure to do so may result in economic loss, property 
damage, and/or personal injury. 

This manual must always be available to personnel 
operating and maintaining this equipment.

Introduction
Chapter 1
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Understanding This Manual

This manual addresses the MatchPoint PLANX precision jigging system.

Separate manuals exist for the Finish Roller, tables, and for any gantry heads used along 
with the MatchPoint PLANX.

Review the table of contents to understand the structure of the chapters and appendices. 
The manual is part number 001098. 

Screen Shots

A screen shot is a printed view of what is visible on the computer screen.

Most screen shots are from MatchPoint software version 1.2.11. Screens from other 
versions may differ slightly.
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Navigation

The graphics in Table 1-1 are used throughout the manual to quickly communicate a 
specific type of information. 

Formatting Cues

To follow the procedures in this manual, you must first understand the formatting cues 
used. Table 1-2 describes how to read the cues provided in this text.

Table 1-1: Navigational Tools Used Throughout the Manual

Graphic What It Communicates
Important safety note!

When this graphic appears, you must lockout/tagout the 
equipment using approved methods described in OSHA 29 
CFR 1910.147 before continuing with the procedure.

Indicates tools required before beginning a procedure.

A note that gives additional information to the steps or 
existing text.

Refers reader to another section, table, graphic, or drawing 
to further explain something.

Table 1-2: How to Read the Formatting Cues

If Text Looks Like... It Indicates... Example in Text
All caps Key on keyboard or button on screen Press ENTER

Initial cap and italic Menu or field or virtual button that 
you must find or select

Click on the File 
menu

Initial cap only, no 
italics

Menu or field or virtual button when 
simply referring to it

While in the Main 
Menu

Plus sign (+) Hold buttons at the same time CTRL+ALT+DELETE
Greater Than sign (>) Next selection File>Open
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Additional Resources

Supplemental Documentation

In addition to the equipment manual, refer to the manufacturer’s documentation for 
individual components. The supplemental documentation is provided at the time of 
installation, or it may be found inside an electrical enclosure. Refer to these documents 
when you need more detailed information on these components than the MiTek manual 
provides.

Web Site

Visit the MiTek Web site at www.omnisaw.com or the MiTek web site at www.mii.com for 
up-to-date information on all MiTek and MiTek equipment. On the MiTek Web site, view 
the latest revision of this manual and all Service Bulletins, or order parts on-line through 
our eStore.

Contacting Us
For technical assistance or to order parts, contact MiTek’s Customer Service Department 
using one of the methods listed in Figure 1-1.

Figure 1-1: Contacting MiTek

MiTek Machinery Division 
Customer Service Department
301 Fountain Lakes Industrial Drive
St. Charles, MO 63301

Web Site
www.mitek-us.com

Technical Assistance
Phone: 800-523-3380
Fax: 636-328-9218
machinerysupport@mii.com

Parts Orders (with part number)
E-mail: mitekparts@mii.com
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MiTek’s Responsibilities

Prior to Installation

MiTek will provide the following items and information prior to the installation date:

1. A Prior to Installation package that:

• Outlines this chapter and requests your signature of agreement.
• Gives dates to expect shipment, delivery, and installation.
• Provides guidelines on providing an electrician, welder, and other specialists.
• Describes payment information.

2. A layout showing how you have indicated that you wish the equipment to be 
arranged within your building.

During Installation

Upon request, a MiTek Customer Service Technician (CST) can be present to oversee the 
installation of your equipment.

Purpose of 
Chapter

Purpose of 
Chapter

This chapter covers what you must consider or complete 
before this equipment can be installed.

Prior to Installation
Chapter 2
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Customer’s Responsibilities
Before the installation of your equipment, the items and procedures in this chapter must be 
arranged, purchased, or assembled. Table 2-1 provides an overview of these items. Each 
topic listed in the table is explained in detail in the text following the table.

If these requirements are not satisfied before the scheduled installation date, it may be 
necessary to reschedule the installation. Any additional cost may be the customer’s 
responsibility.

Table 2-1: Responsibilities of Customer at or Prior to Installation

Space Requirements

This equipment requires enough space to allow for the 
machine dimensions plus additional working space for 
operation and maintenance. 

Space should have adequate lighting. See your layout for 
machine dimensions. See page IN-41 for space requirements 
for maintenance.

Location 
Requirements

Concrete, a minimum of 6'' thick 3000 psi, is required under 
the weight of the tables and Stand-Alone Conveyors. 

The MatchPoint PLANX tables must be operated in a covered 
area without extreme temperature changes.

Electrical 
Requirements

The standard electrical requirements are shown in Table 2-2. 
Contact your MiTek representative immediately if custom 
power specifications need to be arranged.

Shipping Weights See Table 2-3.
Customer-Supplied 
Items Required

The customer is responsible for having the supplies listed in 
Table 2-4 available at the time of installation.

Local Codes: Power, 
Anchoring, etc.

The customer must be familiar with all local codes that apply 
and ensure the equipment in installed in a way that meets 
these codes. See page IN-45 for more details.
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Space Requirements

Space must be allocated for the following:

• Physical dimensions of the MatchPoint PLANX system and all accessories.
• Space between components.
• Adequate space for safe operation and maintenance of the equipment.

Refer to the guidelines below when planning your space allocation. 

Space for the Equipment

It is the customer’s responsibility to provide adequate space for the installation, operation, 
maintenance, and protection of the equipment. Refer to your layout to determine the 
physical dimensions of your equipment. Additional space is required for operation, 
maintenance, and optional equipment.

Space for Operation and Maintenance

Additional space must be allocated for operation and maintenance. Operation space 
should provide safety, freedom of movement, storage space, and free flow of raw and 
finished materials. There must also be adequate space for safe handling of the raw and 
finished materials throughout the process. Refer to your layout for recommended space 
required.

Electrical enclosures and distribution panels must have the required amount of space clear 
in front of them. In the United States, regulations usually require 3 ft, but check your local 
regulations.

The space required is dependent on your maintenance and operating processes. The largest 
truss the system can create must be easily removable from the tables. Each PLANX 
assembly must have the ability to be removed from the tables, either by overhead crane or 
forklift. The PLANX assembly lifts up and out off the tables.

Location Requirements

Floor Structure

A level and structurally sound concrete slab must be provided for the installation of the 
equipment. This slab should be designed and installed in accordance with local building 
code requirements and, if required, under supervision of a professional engineer. Concrete 
should be a minimum of 6 in. thick under the MatchPoint PLANX system. Three thousand 
(3000) psi concrete is recommended. Refer to your layout drawing.

The floor must be level within 3 in. to properly install a system. Equipment installed on a 
floor not level within 3 in. may require shim plate to be supplied by the customer.
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Environment

The equipment must be used in dry conditions under a roofed area according to Type 1 
electrical enclosure requirements. Under no circumstances should the electrical enclosures 
be sprayed with a hose. 

Lighting should be adequate for safe operation and maintenance.

Electrical Requirements

The standard electrical requirements are shown in Table 2-2. Additional voltages can be 
supported through the use of optional transformers. Contact MiTek’s Sales Division if 
transformers are required.

The power supply must have a fused disconnect switch, separate from the power 
distribution panels. The power supply line must reach the power distribution panels.

You must indicate what voltage is available at the machine’s proposed location when 
placing the order. This information must be correct. Depending on the voltage available, 
revisions to the electrical system or a transformer may be necessary.

Table 2-2: Electrical Specifications

Shipping Information

When the equipment arrives, you must have the proper transport and lifting equipment 
available to remove it from the truck and place it in your facility. Table 2-3 lists the weight 
of the individual components of a typical MatchPoint PLANX system.

Horsepower 1/3 hp per motor (2 motors per PLANX, 1-4 
PLANX per table)

Amperage 15 amps
Voltage 240 VAC per every 4 PLANX standard
Phases 3
Frequency 50-60 Hz

! DANGER
Transport and lifting equipment such as forklifts, 
cranes, and straps must be designed and rated for the 
load and application The weight of each major 
component is given in Table 2-3.

Inadequate transport equipment may result in 
property damage, personal injury, or death.
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Table 2-3: Shipping Information

Customer-Supplied Parts

Summary of Parts Required

The customer must supply the parts shown in Table 2-4. Additional details are found in the 
text following the table when necessary. Some parts must be installed before installation 
occurs and some must be available for use at the time of installation. 

Table 2-4: Customer-Supplied Parts

Contents of Shipment Approximate Weight
PLANX assembly 600 lb each
STT 101 tables (with PLANX) 5500 lb each
STT 101 aisle cover (with PLANX) 1200 lb each

Item Description
Electrical 
Equipment

Disconnect enclosure (see additional details)
Strain relief (see additional details)
Power strip and power cords to supply power to the computer, monitor, 
and DC power supply (see additional details).
Electrical requirements for the tables include conduit and fittings.
Consult the requirements for customer-supplied electrical parts on your 
electrical schematic, and speak to your Sales Representative for other 
electrical parts that must be available at the time of installation. 

Transport 
Equipment

Forklift, chains, and spreader bars capable of lifting 6000 lb

Tools That 
May Need to 
be Rented

Transit with measuring stick

Industrial hammer-drill

Hydraulic jack

Welding equipment and welder

General
Tools

Tape measures (2)

Steel tape measures (2)
(longer than total length of tables)

Adhesive tape

1/4-20 tap (2)

#7 (.201) drill bit (2)

Contractor-grade string (longer 
than total length of tables)

Deep well socket: 3/4''

Sockets: 3/4'' (2), 9/16''

Long hex head wrench 3/4'', 9/16''

Allen wrenches: 1/16'', 1/8'', 5/32'', 
3/16'', 1/4'', 5/16''

3/8 drive ratchet with extension

3/4-20 eye hooks (2)

Protective gloves
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Disconnect Enclosure

The Purchaser must provide a Main Disconnect Switch as described here.

EU Requirements

• Switch-disconnect, with or without fuses, in accordance with IEC 60947-3, 
utilization category AC-23B.

• The handle must be lockable in the OFF (down) position and be located such that 
the operating handle is between 0.6-1.9m above floor, recommended < 1.7m.

US/Canada Requirements:

• Main Disconnect Switch: Shall be CSA certified or UL listed and suitable for the 
voltage, current, hp, & interrupting requirements.

• An External Disconnect Shall be Provided to be in Compliance With the US / 
Canadian Electrical Code.

Strain Relief

A strain relief should be provided where the cordset enters the console and it should be 
sized for the cord size capable of pull force of 8N. Cabtite #KEL 32 with appropriate sized 
HDC KT series grommet is recommended.

Power Strip and Power Cord Details

It is the responsibility of the Installer or this equipment to supply a suitable length of 
medium heavy duty supply cordage. It should meet the following requirements:

• It must be approved for use in the country in which this equipment is installed.
• A suitable power strip with 15 amp integral overcurrent protection and grounding 

capability must be selected for connecting to the branch circuit and must comply 
with the National Electrical Code of the country in which it is installed.

• The power strip should be placed in and secured inside the operator console in an 
open area.

• The maximum length of the cordage should not exceed 98” (4.5 meters) or the 
values established by the National Electrical Code in the country where this 
equipment is installed.

! WARNING
ELECTROCUTION HAZARD!

Customer must provide an external disconnect that is 
suitable for the voltage and load of this machine and 
satisfies all regulations according to US and Canadian 
electrical codes.
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• The cordage should be routed to the Control Panel in a manner that does not allow it 
to be stepped on, pinched, subject to abrasion, excessive bending, or other abuse.

• The cordset can provide emergency switching off (ESO) capability if needed. The 
power cord must be placed near an easily accessible, unobstructed socket outlet.

• A strain relief should be provided where the cordset enters the console and it should 
be sized for cord size capable of pull force of 8N. Cabtite #KEL 32 with 
appropriately sized HDC KT series grommet is recommended.

Local Codes and Regulations

The customer must be familiar with all local codes that apply and ensure the equipment in 
installed in a way that meets these codes. The following list identifies some, but not all, of 
the items that should be discussed with local authorities.

• Equipment should be stable under all conditions of use, including seismic events
• Fuse and disconnect regulations
• Grounding regulations
• Emissions regulations
• Space required
• Personal protective equipment required
• Inspections required

Training Provided
The MiTek representative trains your operators and maintenance personnel on the 
equipment’s proper operation and maintenance. The representative explains the warranty 
policy, gives an overview of the equipment manual, and requests your signature to verify 
your understanding of everything discussed.

Refer to the Training Checklist on page MT78 for other training topics.
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Responsibilities During Installation
MiTek will provide installation supervision to ensure that the system is installed properly 
and operates correctly. We will also provide operating and maintenance training at the 
time the equipment is installed. The customer is responsible for providing all labor and 
equipment needed to complete the installation. These requirements are explained in the 
Prior to Installation chapter.

Delivery

Checking for Damage

All shipments from MiTek are covered with tarps. When your shipment arrives, check to 
see that the tarps are in place. Displaced tarps may indicate a potential problem.

After removing the tarps, inspect the shipment for water/moisture, debris, and damage. 
Report any findings as required by the transport company. Document any findings by 
taking photographs or a video. Note any and all damage to the equipment on the bill of 
lading to ensure proper documentation for insurance claims. Without this note, any 
damage in transit is the responsibility of the customer to repair.

Notify MiTek Customer Service of any unacceptable findings discovered during the 
receipt inspection. Although your findings may not appear to be a problem, they may 
cause premature failure of components, poor performance, or erratic performance.

Purpose of 
Chapter

Purpose of 
Chapter

This chapter describes the entire installation process in detail. 
The instructions assume that the prior-to-installation 
requirements are satisfied.

All customer responsibilities before and during installation are 
described in the Prior to Installation chapter!

Installation
Chapter 3
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Unloading

Equipment Needed

Refer to the Prior to Installation chapter for information regarding preparing for the 
delivery.

It is the customer’s responsibility to provide equipment and labor for unloading, 
placement, and wiring of the equipment prior to the arrival of the MiTek representative.

A heavy-duty forklift is required to move the equipment during unloading and placement 
of the machine. If there are any questions regarding the unloading or placement process, 
please contact your MiTek representative.

Component weights are listed in Table 2-3 in the Prior to Installation chapter.

Exercise extreme caution to avoid damage or misalignment during unloading. Do not 
apply pressure on any moving parts or fittings. If using a fork truck, the table should be 
lifted from the middle, with forks evenly spaced on both sides of the center table supports. 
The forks should reach the full width of the table. Figure 3-1 and Figure 3-2 show how to 
lift and move the equipment safely.

! WARNING
CRUSH HAZARD.

Failure to lift the equipment in the prescribed manner 
may cause serious injury, including death, or 
equipment damage.

Personnel not involved in the off-loading from the 
truck shall remain clear of the area. 

Transport and lifting equipment such as forklifts and 
cranes must be designed and rated for the load and 
application.

! CAUTION
Use two people when manually lifting anything over 40 
lb (18 Kg).

The following items weigh over 40 lb (18 Kg):

• Operator’s control panel

• Power distribution box

Refer to...
Table 2-3 for the 
weight of each 
component
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Lift Points

Lift the table or PLANX assembly as shown in Figure 3-1 and Figure 3-2 using lifting 
equipment rated appropriately for the weight.

Figure 3-1: Lift Points for Table

Figure 3-2: Lift Points for PLANX Assembly

If an overhead crane is not available, a forklift may be used to move the PLANX assembly 
if the following guidelines are met:

• Use a minimum of two (2) forklifts and strap the PLANX assembly to both forklifts.
• Do not put pressure on any parts other than a flat, smooth surface.
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Unpacking

After successful unloading, remove the protective crating material from the pallets. 
Detach and set aside all loose parts. Move the equipment to the desired location using a 
forklift or crane appropriate to the weight of each unit. Lift the equipment to remove the 
pallet, and gently place each unit in its new location.

Returning Shipping Material

PLANX that are not shipped in tables are shipped using PLANX shipping stands. These 
shipping stands must be returned to MiTek’s Fountain Lakes facility. 

A MiTek representative will contact you to schedule a return date, and will send you a 
return goods authorization (RGA). To return your shipping stands, fill out the RGA and 
bundle all the PLANX shipping stands on one skid. If you do not return the shipping 
stands, you will be billed for them.

Equipment Layout
Each component must be located in a specific location. Refer to your layout during 
installation. Your MiTek representative will provide your layout to you before the 
equipment is installed.

When PLANX are provided with MiTek tables, the tables will be shipped with PLANX 
installed. When PLANX are provided for other manufacturers’ tables, the PLANX will be 
installed on-site.

! CAUTION
TRIP HAZARD!

Secure or cover all hoses, power lines, and conduit so 
they are not trip hazards.
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Electrical System

Checking Existing Wiring

Heavy gauge wire can work loose during shipping and handling. Before power is 
connected to the machine, conduct a pull test on all pre-wired connections inside the 
electrical enclosures.

Connecting Power to the Equipment

All electrical work is the customer’s responsibility and must be performed by a licensed 
electrician. The machine design addresses electrical components starting with the 
disconnect enclosure. Installation and maintenance of all electrical requirements up to the 
disconnect enclosure are the responsibility of the customer. Your MiTek representative can 
provide guidance regarding when the electrician will need to be available during the 
installation.

! WARNING
ELECTRICAL HAZARD!

All electrical work must be performed by a licensed 
electrician.

Follow approved lockout/tagout procedures
(OSHA 29 CFR 1910.147).

NOTICE
You must ensure proper grounding when leveling and 
welding the tables. When PLANX are installed, 
improper grounding could damage the circuit boards.

Do not hook up power until all welding is complete. 
Welding on tables with electrical and communication 
lines hooked up could cause serious damage.
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The customer must supply the disconnect enclosure.

Connecting Power to the PLANX

Connect power to the table enclosures by running wire from the distribution panel to all 
power distribution panels. Refer to your schematic and state and local codes for wire size.

Installing the Operator Console

Connecting Power to the Operator Console

Connect power from the distribution panel to the operator console. The PC and display 
can operate at 120 or 240 VAC.

Connecting Communication Lines to the Table Enclosures

1. Run the RS485 communications line from the operator console to the first power 
distribution panel. 

2. Connect the incoming RS485 communications line from the operator console as 
necessary to the communication card in the power distribution panel. Refer to 
your electrical schematic for proper wiring. 

3. Connect the communication cable between the power distribution panels. A cable 
is supplied in each power distribution box with one end terminated. The other end 

! DANGER

DO NOT ATTEMPT TO START THE SYSTEM WITHOUT 
A MiTek REPRESENTATIVE PRESENT!

Serious injury and/or equipment damage may result.

! CAUTION
Use two people when manually lifting anything over 40 
lb (18 Kg).

The following items weigh over 40 lb (18 Kg):

• Operator’s control panel

• Power distribution box
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is to be terminated by your MiTek Customer Service Representative. Refer to your 
electrical schematic.

Connecting Communication Lines Between Table 
Enclosures

Use 3/4-in. rigid metal conduit and CAT 5 stranded cable for communications between 
junction boxes.

1. Connect the CAT 5 stranded cable between the connections on each 
communications card.

2. Plug another patch cord from the second T-Tap into the T-Tap of the following 
table.

3. Continue until all PLANX are connected to the operator console. 

Connecting the PC

1. Connect the 9-pin serial port on the PC to the JSP console card at H2 using a serial 
communications cable.

2. Connect the 37-pin parallel input/output card on the PC to the JSP console card at 
H3 using a parallel input/output cable.

There is one power distribution panel for every four (4) PLANX.

For information on connecting your computer monitor, keyboard, and mouse, 
consult the documentation for the computer.



MatchPoint PLANX™ Jigging System

001098 Rev. B Installation
IN-53

Installation Checklist
 Check equipment for damage
 Unload equipment
 Unpack equipment
 Check existing electrical wiring
 Connect power to the tables
 Install the operator console
 Install any remote consoles
 Connect communications lines between the table enclosures
 Connect the PC
 Secure or cover all hoses, power lines, and conduit.
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Setting Up the MatchPoint Software

Software Logins

Logins can be set for Technicians and Administrators by selecting Tools>Options, then 
selecting the Security tab. 

Certain functions of the software are only available if the operator is logged in as an 
Administrator. These functions include: 

• All functions located under Tools>Options
• All functions located under Tools>Admin
• Diagnostics
• Calibration

To log in, select LOGON/OFF from the Actions menus at the bottom of the software 
screen.

Company Information

Before operating your MatchPoint software, you should fill in your company’s 
information. This allows your software to be identified for support purposes. 

1. Select Tools>Company.

2. Enter your company’s information in the appropriate boxes.

Purpose of 
Chapter

Purpose of 
Chapter

This chapter describes the procedures required before operating 
your equipment.

Startup
Chapter 4
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Checking PLANX Addresses

Before operating the MatchPoint PLANX, verify that all PLANX pucks are addressed 
correctly and are successfully communicating with the console assembly.

1. Select Diagnostics from the menu.

2. Select the Scan tab.

3. Verify that each PLANX status reads “HomedAndReady” in the State column. 

4. If PLANX status in any row does not read “HomedAndReady,” see Replacing an 
Electrical Card on page MT58 to correct the PLANX addresses.

Calibrating the PLANX

You must calibrate the machine before use. See Calibrating the PLANX on page MT47 for 
more information.

Safety Test

See Safety Test on page MT10 for the proper test procedure.

! WARNING
CRUSH HAZARD.

Perform the safety tests described before operating 
the equipment at the initial startup, after performing 
any maintenance, and in accordance with the 
maintenance schedule.
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